Magic Mirror

Part 1

How to customise the content



Creating Your Own Magic Mirror Apps

The Magic Mirror software concept:

The Magic Mirror, much like other computer programs, consists of a file (or a document)
that can be worked on and saved. Think Microsoft Word for example; a document is

created, edited and saved. Later, a new document can be created and saved in the same

way.

The apps that you see in the Sequencer are simply "layers” within the same document.
These "layers" are known as Levels in the Magic Mirror. For example; "Jack In The Box"
is on Level 1 while "Stars" is on Level 2. When you click on "Stars" while "Jack In The

Box" is open, you are simple switching between Levels 1 and 2.

We are now going to look at creating a new file of our own and adding a second level to it,

essentially creating two new apps!

The files in this tutorial are available at the bottom of the page, feel free to work along with

them, or use your own in place of them.
For this tutorial, it is recommended that you start a new file.

Open the Magic Mirror. Click File (from the very top tool bar) and select New.

File | Picklist Options Window Settings H

Mew

Load Background
Load

Merge

Save

Save as

Save with Sounds
Save Background

DefaultPositions



You will now have a fresh file to work with.

It would be a good idea at this point to save the new file. Click File>Save As. When the

Save As browsing window appears, navigate to the Magic Mirror folder (C:\ Program

Files\Magic Mirrory,) and look for the folder named "Settings". Give your file a unigue

memorable name and click Save.

g Save As — g
Savein. |, MagicMimor &) 2 £ @~
e 1/ Images
e S 1. Mirror DMX.dIl's
Recent Places | || Settings
| J Sounds
- . tools
Desktop JJ USB_DMX
=
Libraries

Note: the software, once opened, will load the default file (MagicMirroriMaster. Cfg). To

load your own file, click File=Load - or Crt+O and navigate to the Settings folder. Open

the Settings folder, locate your file and click Open.
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From the Elements panel under the Create column, click "Field". You will notice a small
Field Element appear on the Working Monitor and a green square followed by a number

(the Level) and the work Dyn (which is short for Dynamic Field Element).
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drag to make it larger.

To make the new element easier to work with, click the bottom-right anchor point and
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cdad

Now move the element. It is a good idea to do this now, as any further elements created
will appear in this area so will be overlapped and tricky to get to. Click on a boundary line
anywhere between the anchor points and drag to move (like drag and dropping items on

your desktopt).

i Part of boundary
line to click on

Anchor points

Move up to the Elements panel and click on the More tab (under the Properties column).



Properties

Midi-Note | Midi-Control | Samples | Visual | Video | asc ||Mu-re |
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Click the "Def Glyph" Brose button and locate the image you wish to use. In this case, the

image "PinkFlower.png". Do the same for "Trig Glyph" but this time, select the image

"RedFlower.png". The two options will now show the image files that have been loaded,

like this:

Properties

Midi-Note | Midi-Control | Samples | Visual | Video | osc ||Mure |

Def Glyph |ExtutoriahPinkFlower.png

Browse

Trig Glyph |ExutoriahRedFlower.png

W SE

Tip!

If you don't see any images where you would expect to find them, click on the drop list for

"Files of type:" at the bottom of the Browse window and select "all files":
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If you wish, you may test your progress by moving down to the Control Panel and

pressing the Play button. Move over your element to see it triggered and the second
image displayed!




The next step would be to add some sound. Move back up to the Elements panel and

click the Samples tab under the Properties column.

Properties

Midi-Note | Midi-Control ||5ample3 | Visual | Video | 0sC | More |
Soundfile | New  View Delete | List Rewind |
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Click "New" and locate the file "HarpBloom.wav". Once loaded, the Samples tab will now

show the file, like this:

Properties
Midi-Note | Midi-Control ||5amph_=,:s. | Visual | Video | osc | More |

Soundfie | New View Delete | List Rewind |
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Again, if you do not see the sound file you are looking for, click on the drop list for "Files of

type:" at the bottom of the Browse window and select "all files” (as above).



Test your progress once again to hear the sound now accompanies the image change

when triggered.

Cast your mind back to the start of this tutorial, in the Elements List that contains
information about the element. The number 1 is significant because it is the Level at

which the element resides.

In order to make this work an app in its own right, let's give the app a namel

This is done with a small and simple piece of code typed into the Sequencer:

P

?3 Sequencer E'E'@
Edit | Inzert

Levels
1Grn 2Yel 3J3Blue 4Weiss 5Red

1 GRdq Gl lg Gl g Gl G
= = = = =

01:19:49

Notice that "Run" is highted. Also note the large white box below.

Click "Edit" and you will see that the large white box becomes editable.

-

7 Sequencer [ | @ |l
Run | Inzert

Levels
16Gm 2%Yel 3Blue 4Weiss 5Red

1m1m1m1m1m
(€3] (€3] (€3] (€3] (€3]

01:21:34




In the large white box, we are going to type some words that will signify our element's

Level as an "app".

Before we do so however, we will need to type a piece of code that will initiate the
process. This is because we are working on a new file for the first time. Once this is
entered, it need not be done for this app again, the following code is a two part command
to tell the software to produce a secondary monitor ie; the Projected image (the "MO"

part) and take a snap shot of the background for optimum use (the "BK" part)

The one-off code to type here is: "MO+ BK"

-

?? Sequencer =aac [ﬂ]
Run | Inzert

Levels
1Grmn 2%Yel 3Blue 4Weizs 5 Red

1 g g Gl g G g G
S| S| S| S| S|

MO+ BK

00:09:58

While we still have the Sequencer in edit mode, we may as well type the next part of

code. The following code is required for each app you wish to create:

G171 =MName of app

where "G1" refers to the element. In this case G stands for "green” (the default colour
given to an element when created. This need not be changed for these purposes)and the
number 1 stands for "Level 1". And "Name of app" is your chosen name for the app you

wish to create.

We need to type this new code on a new line. So, make sure the Sequencer is in edit

mode, click immediately after MO+ BK and press return to enter a new line.

Type "G1 = Flower". Keep the Sequencer in edit mode for now.
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Levels
1Grmn 2Yel 3Blue 4Weiss 5 Red

Al =] ] ]

MO+ BK

G1 = Flower

Let's type the code for the next app. Even though we have not yet created any content for
it, it is a good idea to get this part done now as when the new app is selected, the next

Level will automatically be selected for us to work on!

Again, go to the end of the previous line (in this case to the end of "G1 = Flower") and

press return.
Type in the following:
IIGE = DDg"

This creates a new Level for our new app!

E dit | Insert

Levelz
1Grn 2%Yel 3Blue 4Weiss 5 Red

Al | ] ]

MO+ BK

G1 =Flower

G2 =Dog

00:04:26




Mow click Run.

Test your progress by now clicking on the next app. To do so, simply move the mouse

cursor over the line that says "G2 = Dog" in the Seqguencer and sing-click it.

You should notice that the flower of the first app disappears. This is because we are

switching to Level 2 (the next app). Let's put some content on it!

With the Dog app selected, create a new Field Element (as above). As before, move to
the More tab in the Elements panel. For Default Glyph load the file "Dog1.png"”. For the

Triggered Glyph, load "Dog2.png". Under the Samples tab, load the file "DogBark wav".

You now have two appsl!

Note: If you would like to add to either of your apps, simply select the app you wish to add
to (by clicking on it's name in the Sequencer) and create new elements as desired. Any
new elements created will be created on the same Level hence they will all be a part of

that app.

If you want to create a new app, first enter the new app's code as we did for app 2, click

Run and with the newly created app selected, go about creating new Elements.

You will need to save any changes you make, if you wish to keep them, each time you

close the software.

PinkFlower png (30 KB)
RedFlower png (30 KB}
Dog1.png (30 KB)
Dog2.png (30 KB)
DogBark. wav (20 KB)
HarpBloom.wav (200 KB)



Magic Mirror

Part 2

The system



How Do | Turn The System On?

There are a few things you need to familiarize yourself with before you attempt to turn the

system on for the first time:

1. PC and Monitor - this will usually be housed in a dedicated server rack or on a

shelf close to the projector

2. Projector - mounted on or above the ceiling and controlled by an IR remote

control unit

3. Amplifier - powers the speakers

To begin with turn on the main power switch and make sure all equipment is in standby

mode. You can tell that the equipment is in standby mode by checking the status of the

standby LED's.

MNext switch the PC on using the button on the front of the PC. The Monitor will turn on

automatically and you will see the Magic Mirror software begin to load.
Note: if the Monitor doesn't come on, turn on using the Monitor's power button.

Note: if the Magic Mirror software does not load automatically, locate the icon on the

Desktop and double click to run.

Locate the Projector Remote and turn the projector on. When the projector warms up and
shows the image it should display the Magic Mirror's output screen with the first app in the
list visible. If you don't see this, but instead see the extended PC Desktop (as standard,
this is a Sensory Guru logo), then this is most likely because the software is not running.
Locate the icon on the Desktop and double click to run. If you see nothing at all, check the

projector input is set to Computer 1. This is the button directly below the ON button of the

Projector remote.

The system is ready to use. Simply press Play on the Control Panel to activate.



Magic Mirror

Part 3

How to start using the Magic Mirror



How Do | Start Using The Magic Mirror?

Once the system is powerad on, you may begin to use the apps.
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Start by selecting the app you wish to use from the Scheduler (B). To do so simply click
on an app name (such as Jack In The Box) with a single-click using the left mouse button.

The app is now selected and should appear on your Projection wall.

The next step is to activate the Magic Mirror. This is done by pressing the Play button on

the Control Panel (D).
The system is now active and ready for use.

You may now switch between apps by simply clicking on the app name once (as above).
The scene will change and be instantly ready for use. Elements may be freely moved
around the screen by clicking anywhere on an their green boundary line (between the

anchor points [the little white squares])



Tip!

Be careful when moving elements, especially if there is a background image underneath.
If you don't quite place the mouse on the boundary line, it may click through fo the

element below, moving that one instead!

When you are finished using the system, close down the software by clicking the red box
with the white cross at the top-right part of the screen (the same way most Windows
applications are closed). If you have made any changes, a message will appear asking
you if you would like to save them. Click "Mo" if you do not intend to keep changes or wish

the system to be reset back to the default for the next use.



Magic Mirror

Part4

Software Guide



The Elements Panel
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The Elements panel is where you set parameters for new or existing Interactive Elements.
Mote that this panel is made up of various columns, namely; "Create”, "Elements List",
"Options", "Fields" and "Properties”. The commonly used options from each (highlighted

in pink above) are defined as follows;

Line {from the Create column) is a single line shaped Interactive Element. When you click
on this button, a small green line will appear at the top left of the Working Monitor. You
will notice two white squares at either end of the Line. These are anchor points and can
be clicked on to resize and change the angle of the element. A good place to start once
created is to click and drag the bottom-right anchor point so that the Line is larger and
easier to work with. The Line element works well with a scale of midi notes set - moving
along the line from left to right causes the notes to move up in a scale, say C major.

Moving from right to left causes them to move down the scale.



Field (from the Create column) is a box shaped Interactive Element. When you click this
button, a small green box will appear on the Working Monitor. The newly created element
will have a green boundary line and eight white squares at central peints around the
boundary. These white squares are anchor points. They may be clicked and dragged
around to form a new shape or size for the element. If you click carefully on the green
boundary line and hold it, you will now be able to drag the element around the screen to
where you want it. A good tip for creating Field Elements is to immediately resize it by
clicking and dragging the bottom-right anchor point. Drag the point so that the element is
now larger and easier to work with. A Field works well with two images (one as a default
image that sits there until the element is triggered, and a second that is assigned to

appear when triggered) and a sound (to play when triggered).

Activation Dynamics

Sensitivity, Threshold & Filter from the Fields column, applies to Fields. By default the
settings are 0.30, 0.21 and 10 respectively. These settings are generally suitable for most
environments. However, if you are finding an Interactive Element to be unresponsive or

too sensitive, try adjusting the settings to suit.

Sensitivty and threshold work together to set a Field Element's overall sensitivity;

Sensitivity

Sensitivity relates to movement. The higher the sensitivity value the more easily the
element will detect movement. For example; the sensitivity is set high, the element

detects even the slightest of movement from a wiggling finger.

Threshold

Threshold relates to a value at which the element will trigger. Even though the element is
set to a high sensitivity level and is detecting the movement from the wiggling finger, the
element has not yet triggered. 1t will not trigger until the finger movement becomes more
prominent and breaks through the threshold value. In this case, it is necassary to either

reduce the threshold level, or increase physical movement to trigger the element.



Filter

The Filter option determines how quickly the Field Element resets after being triggered.

For example; if increased in value, the triggered event will play for longer.

If the value is very low or set to zero, the element will reset itself almost instantly after
being triggered. If the Filter is set in this way, you may experience a 'bouncing' trigger
event. This is where the element is triggered, resets very fast and triggers

instantly producing a bouncing effect. To reduce this effect you may set the Debounce
value a little higher (the Debounce setting is to the left under the Options column). A value
of around 2 will redcuce this unwanted effect sufficiently for most situations. Unless of

course, that's the effect you are looking forl

The Properties column

This is where elements get their image and sound settings assigned.
The Midi-Note tab

Propertiez
||-.um.mme| Midi-Control | Samples | Visual | Video | 0sC | More |

) NoNote  rort Bank
1 - Microsoft G5 Wavetable Synth > |0 |&
() Repetitive Patch Channel
© Permanent 1 Acoustic Piano - 1 |%

Mote From Mote To “WelFrom WelTo Vel Def
Cameteort g o5 ) e8] [78) 7S] [0 1D
[] welocity

Arpeggio Chord

Scale

The Midi-Mote tab allows you to set Midi sounds to elements. Here is a good example of

how to use Midi-Note settings;



Create a Line Element (as above). With the Line Element selected, go to the Properties

column and select Midi-Note.

Click on "Single" (directly underneath Midi-Note. This will produce a single note/sound
when the element is triggered). Now, where it says Patch (to the right) select a musical
instrument from the drop down list. Undemeath, where it says "Note From" select the note
you wish to start from, in this case C5. Mow select the note you wish to to end with, we
have selected C6 here. This means that all notes between the note C5 and C6 will be
played (C, D, E, F, G, A, B and C - an octave above) as you physically move along the

Line Element!

As a further feature, underneath where it says "Scale", you can pick out certain notes that
you wish to be played when the element is triggered. The notes must be entered in
number form, so it is necessary to know what the number values are for each note where

the first note is 0.

Here is an example of the relationship between the actual notes and their respective

number values:

C# D# F# GH# A#




If you enter the following into the Arpeggio box; "0,2.4 6" - only the notes C E G and B will
be played when the element is triggered. Further still, if you were to enter "0,0,7,7,9.9.7"

you would have the first bar of Twinkle Twinkle Little Starl
The Samples tab

Froperties
Midi-Note | Midi-Control ||San‘|ple-.s. | Visual | Video | osc | More |

Soundfile i List Rewind |
Use C\MagicMirror\Sounds\Peopletheehee. wav

[ Loop Simutaneous -

Restart always

[] Permanent [] Solo

Volume Range: 0.1 Pan Frequency
From To From Ti From To

1]
[1.00 [ & [1.00 |Z| o [Bllo 1B 100 B 100 |
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The Samples tab allows sound files (samples) to be assigned to elements.
A good use of the Samples option is as follows:

Create a Field Element (as above). With the new element selected, click on the Samples
tab. Click "New". This will bring up a browse window where you can navigate to a sound

file you wish to use. Once you have selected the file, it will appear in the list below.

The next step is to give the sound event a setting. There are three options here; Loop,

Restart Always and Permanent:

Loop will cause the sound to pause when triggering stops. The next time the element is

triggered, the sound will pick up where it left off.

Restart Always will restart the sound each time the element is triggered, even if triggering

stops half way through the sound.



Permanent will play the sound to the end, much like a switch. Once triggered, the sound

will be played through to the end regardless of whether triggering stops or not.

Rather than just one sound file, you may have multiple sounds loaded - they will appear in
list form. The idea here is that you have a different sound each time the element is

triggered.

The More tab
Properties
Midi-Note | Midi-Control | Samples | Visual | Video | osc ||I'|'Iure |

Def Glph | CaMagicMirrorimages\box\box.png
Trig GlPR | C\MagicMirrorimages\boxibox chinchila.png | [Browse

Command (Segquencer-Style)
On Off Value From To

| | | o 1B [0
Exmpl: G%1.0f Range: 0..127

|:| Suppress Autobackground

DM Channel

L) 7] L) L)
] 1.512 1 |EJ Frnm|u |EJ|T|J |255'|IEII|II|IET|JI |EJ|
Select Anchor
none -

The More tab allows up to two images to be assigned to an element. This concept works

best with Fields, for example.

Create a new Field Element (as above). Click the More tab. Notice the two available
spaces for images underneath; Def Glyph and Trig Glyph which in turm, mean "Default
Image" and "Triggered Image". The Default being the image that is shown when the
element is not triggered/inactive. And Triggered being the image that appears when the

element is triggered. They may be any images of your choice.

Click "Browse" on the first image option. Navigate to an image you wish to use and select
it. It will now appear in the white space next to Def Glyph. Click on the next Browse option

and do the same, but this time with a different image.



Test your image by moving across the element. You will see the picture change as it is

triggered.

You may also set a sound to this same element by following the previous two sound

option methods.

If you do not want the image to change when friggered, then set the same image to both

Def and Trig Glyph options.



Graphical User Interface (GUI)
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By default, the software will show a simplified interface. There are four main panels that

you will need to familiarise yourself with;

A The Elements panel. By default this is closed, as it is not required for general use of
the apps. For editing content however, it will need to be opened (by hovering the mouse
over the bottom edge anywhere along its length - until a double ended arrow appears.

Click, hold and drag the arrow downwards to expand the panel).

B: The Sequencer. This is a kind of playlist of apps contained within the Magic Mirror. In
order to select one, simply move the mouse cursor over an app name and left-click on it

once. This will change what is seen on the Projection.



C: The Working Monitor. This shows the Magic Mirror from a facilitator's point of view.
You can see what the camera is seeing and the overlaid Interactive Elements (green
boxes) in outline form. Here you can move and resize the Interactive Elements around the
screen as required (click on the boundary line, away from the anchor points, hold and
drag to move. To reshape or resize, click on any anchor point (little white squares that are

spaced evenly around the boundary ling), click, hold and drag to a new shape/size).

D: The Control Panel. This is like the on and off button. To begin using an app, click on
the Play button. This makes the system active and Interactive Elements are now live.

When you press the Stop button, the system becomes inactive.
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Troubleshooting



Debugging The Camera (Using Amcap)

Amcap is a program we use to configure a camera connected via composite connection.
For example; the cameras used by the Magic Carpet or Magic Mirror systems. Amcap can
be opened by double clicking the Desktop shortcut icon if one has been created. If there

is no shortcut icon, you can find Amcap here: C\Program Files\Wagic Mirroritoolsh

Once open you will be presented with the main interface. Mote, that if the camera is
plugged in and set up correctly, you will see the camera image. If not, then there will be

either a complete black or white image instead.

Locate the "Options" menu at the top:

File Devices Options Capture Help

The Options menu contains some further options: "Video Capture Filter”, Video Capture
Pin" and depending on what version of the software you are running, you may have

"ideo Crossbar”



Options | Capture  Help

v | Preview
MPEGZ

Wideo Capture Filter...
Yideo Capture Pin...
Video Crossbar...

Let's go through the correct settings.

From the Options menu, select "Video Capture Filter". Look at the Video Decoder tab and
make sure the Video Standard option is set to "PAL_B". Click "Apply" and then "Ok" to

exit.

Video Decoder | \ideo Proc Amp | Wdeo Image |

Wideo Standard I PAL_B

Signal Detected: 0

Lines detected: 0

[~ VR Input

-

IJ5E 2861 Device




Next, select "Video Capture Pin". Video Standard should automatically be set to "PAL_B"
having just set that in the capture filter panel. Set the Frame Rate to "25.000" and Make

sure the Output Size is set to "704 x 576". Click "Apply" and then "OK" to exit.

Video Format

Video Standard: IPAL.B
Frame Rate: Izs.ooo :I { Frame Interval: [—:IJ
Flio Horizortal, [ _Snap shot | PFramelntervaI:'_jl

Color Space / Compression:
[ror2 =
Qutput Sze: Quality: I 1.000
v

'USE 2861 Device




Finally, (if your version shows it) select "Video Crossbar”. In the first section, Input, select

"1: Video Composite In". Click "Apply" and then "OK" to exit.

=
Current inpet:

1: Video Composite in
Related Pin:

4; Audio Line In

™ Link Related Streams

Concel | Mooy |

If your camera is correctly connected and powered, with these settings, you should now

see an image in Amcap.

Close Amcap.

Note: Make sure Amcap is correctly configured and CLOSED before starting the
Magic Mirror software. There will be a conflict and subsequent error message if

trying to run the Magic Mirror and Amcap together.



System Not Responding To Interaction Or Intermittent

Interaction

Make sure you have pressed Play on the Control Panel to ensure the Magic Mirror is

active.

If you are finding your Interactive Field Element to be unresponsive or too sensitive, try
adjusting the settings to suit. This may occur in very low/very high ambient light situations
or where the environment allows for direct sunlight or concentrated light in certain areas

around the room. For example; one of your elements is sitting right over a bright window.
Sensitivity, Threshold and Filter settings (Elements panel > Fields column)

Sensitivty and threshold work together fo set a Field Element's overall sensitivity;

Sensitivity relates to movement. The higher the sensitivity value the more easily the
element will detect movement. For example; the sensitivity is set high, the element

detects even the slightest of movement from a wiggling finger.

Threshold relates to a value at which the element will trigger. Even though the element is
set to a high sensitivity level and is detecting the movement from the wiggling finger, the
element has not yet triggered. 1t will not trigger until the finger movement becomes more
prominent and breaks through the threshold value. In this case, it is necassary to either

reduce the threshold level, or increase physical movement to trigger the element.

The Filter option determines how quickly the Field Element resets after being triggered.

For example; if increased in value, the triggered event will linger for longer.



If the value is very low or set to zero, the element will reset itself almost instantly after
being triggered. If the Filter is set in this way, you may experience a 'bouncing' trigger
event. This is where the element is triggered, resets very fast and triggers

instantly producing a bouncing effect. To reduce this effect you may set the Debounce
value a little higher (the Debounce setting is to the left under the Options column). A value
of around 2 will redcuce this unwanted effect sufficiently for most situations. Unless of

course, that's the effect you are looking forl



Why Isn't There Any Sound?

Before proceeding with froubleshoofing sound, make sure the PC has not been muted.
Also make sure you have pressed Play on the Control Panel to ensure the Magic Mirror is
active. Navigate to the bottom right of the Desktop screen and locate the speaker icon

(within the tooibar). Click it to reveal the volume slider. Adjust as required,

If you have a fixed installation, your system will be connected to either an amplifier or an
existing sound system. Locate the amplifier. Ifit is a Nuvo amplifier(small white unit),

make sure it is on by slowly turning the volume knob fo the right. (turned fully left will tum

the amp off).

If you have a black Cambridge Audio amplifier, make sure the volume knob is turn up
sufficiently (but not too highl). Make sure the source selector is set to the correct source.
This is usually 'CD' or 'MP3' depending on your setup. If either of the do not work, try
slowly selecting each source until the sound comes on.If your system is connected to your

own sound setup, check that you have it set correctly.



Why Can't | See A Computer Image Displayed Through The

Projector?

This is a very common issue people experience when operating projectors, which can
usually be rectified very quickly. Most projectors have multiple input sources to make it
possible to connect more that one PC or video device. if you have turned on both the PC
& Projector, and the Projector displays an image like the one below (image varies
depending on the make and model, but all have a version of this) it is likely that a different

image source has been selected.




Solving this issue is usually as simple as selecting the correct source from the remote

control. All Magic Mirror systems will be set to display on Computer 1 or Computer 2.
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Very occasionally the issue may have a different cause. If someone has accessed the

rear of the PC or needed to access the ceiling near the Projector, it is possible that the
VGA Cable has been disconnected from the PC or the Projector. Please see articles

relating to Magic Carpet component list for more info.



USB Video Capture Device

The USB Video Capture Device enables the analogue video signal from the camera to
communicate with our Magic Mirror software. It is plugged into a USB port at the back of
the PC and has several wires attached to the back of it. The only wire we are concerned
with is the video signal wire (which is usually yellow). This should have the video signal

from the camera plugged into it.

A USB Video Capture device:
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The connection between capture device and the camera's output (note that the plugs are

not always yellow, some may be black):




Power To The Camera - 12V 1A 2.1mm DC Plug

Camera's supplied with Magic Carpet systems are powered by 12V Power Supply's. If you are
experiencing problems with connectivity or the system appears to be unresponsive to user
interaction, check that the LED array on the camera is glowing red as shown below. If not,
then it is likely that the Camera is either unplugged or turned off. Rule this out first before

following the next senes of steps!

When you are sure that the Power Supply is turned on and all connections are good we need

to determine whether the issue is with the Power Supply or the Camera:

» Locate an alternative 12V PSU 1A 2.1mm DC Plug and connect to the system - if
your system is under warranty or you have taken out our Package PRO Service

Level Agreement we will send you a replacement - contact us.




